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Tutorial ArcGIS Desktop 

 

Introducción a la Interface gráfica de ArcGIS 10.1 

 

ArcGIS es una familia de productos de software para construir un SIG. Integrable con 

otras tecnologías. Está compuesto por varios productos, de los cuales se abordará 

ArcGIS Desktop con el fin de poder trabajar con información y conocer el uso básico 

del componente.  

ArcGIS Desktop tiene dos componetes principales como lo son ArcMap (aplicación 

para entrada de datos, búsquedas estadísticas y geográficas, además de output 

(mapas impresos)) y por otro lado está ArcCatalog (herramienta para organizar y 

documentar los datos geográficos (metadata)).  Además dentro de las herramientas 

contiene la caja de ArcTools (utilizado en el geoprocesamiento: combinar capas de 

información, transformación de sistemas de coordenadas, análisis espacial, entre 

otros). 

En este tutorial se tratará de elaborar ejercicios necesarios para el uso básico del 

software.  

 

Ejercicio 1. Inicializando ArcMap 

1. Inicie el programa ArcMap dando un clic sobre el ícono  que está en el 

escritorio. Seguidamente se abrirá un cuadro de diálogo como lo muestra la figura 1. 

Aquí usted tendrá varias opciones para abrir proyectos. 
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Figura 1.  Ventana de inicio de ArcMap 

 

 

 

 

 

 

 

Permite abrir un proyecto ya existente/ 
Seleccione My Templates / Blank Map y OK 

Permite abrir un proyecto ya existente/ De clic sobre Browse for more... y seleccione 
el lugar donde se encuentra el proyecto 
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2. Con el siguiente icono   usted puede agregar capas o shapefiles dando un 

clic y navegando por las carpetas de archivos. Usted visualizará la ventana de la 

figura 2.  

                  

 

Figura 2.  Archivos de la carpeta, llamado de temas o shapes files. 

 

 

3. En la carpeta "Práctica ArcGis 10.1", seleccione el archivo que desea agregar y de 

un clic al icono Add para añadir el archivo redcam_GAM_CRTM05.shp. Este es un 

archivo vectorial de líneas, que contiene las carreteras del Gran Área Metropolitana 

en la proyección Costa Rica Transverse Mercator (CRTM). ¿Con cual datum esta 

asociado este tipo de proyección? 
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4. Ahora usted observará en su pantalla una vista similar a la que se presenta en la 

figura  3.  

 

 

Figura 3.  Interface del Data View 

 

Si las coordenadas no están en metros, debe ajustar las propiedades de la vista en la 

barra principal de herramientas seleccione View => Data Frame Properties => 

General => Units => Display => Meters.  Tal como se muestra en la figura 4. 
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Figura 4.  Pasos para la definición de las unidades de la vista 

 

 

5. Ahora active la barra de herramientas básica desde Customize => Toolbars =>  

Tools. Ver figura 5.  
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Figura 5.  Activación de barra de herramientas 
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Usted observara la siguiente barra de herramientas en la parte superior de su 

pantalla.  

                        

Figura 6.  Barra de herramientas Tools 

 

A continuación se describe una tabla con las funciones de las herramientas Tools: 

 

 Zoom In.  Amplia la zona donde se hace 
clic o se dibuja el rectángulo. 

 Select Elements.  Selecciona, mueve y cambia el 
tamaño de los gráficos en pantalla. 

 

 Zoom Out.  Disminuye y muestra la 
zona donde se hace clic o se dibuja el 
rectángulo. 

  Identify.  Muestra los atributos marcados 
colocando los datos de la tabla en una ventana propia, 
que muestra solo las propiedades de los objetos 
investigados. 

 

 Fixed Zoom In. Aumenta la vista a 
partir del centro. 

 Find.  Permite buscar elementos en el mapa por 
palabra clave (busca en la tabla de atributos). 

 

 Fixed Zoom Out. Disminuye la vista a 
partir del centro. 

 Measure. Sirve para medir interactivamente las 
distancias entre los puntos A y B, o de un camino 
compuesto por varios segmentos de línea. 

 Pan.  El "desplazamiento lateral" de los 
datos, nombre derivado de la técnica 
cinematográfica panorámica. 

 Find Route.  Encontrar una ruta entre las paradas 
que se especifique. 

Full extent.  Muestra toda la extensión 
del mapa. 

 Go to XY.  Escribir una ubicacióbn XY para 
encontarla.  

 Go back to previous extent.  Muestra 
la vista en la escala observada con 
anterioridad 

Create Viewer Window. Crear una nueva ventana 
del visor arrastrando un rectángulo 

 Go to next extent.  Muestra la vista en 
la escala original, antes de utilizar la 
herramienta anterior. 

 HTML Popup.  Abrir una ventana emergente de 
información haciendo click sobre una característica. 

 Select Features.  Permite seleccionar 
objetos de la vista posando el mouse sobre 
ellos. 

  Time Slider. Abrir la ventana deslizador de 
tiempo para controlar el período de tiempo 
representado por los datos en este mapa 
desactivar si ninguna de las capas del mapa tienen 
propiedades de tiempo permitido. 

 Clear selected features.  Anula la 
selección de las funciones seleccionadas en 
todas las capas. 

 Hyperlink.  Hacer un hipervínculo a una página 
web, documento o script haciendo clic en una 
característica. 
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Ejercicio 2. Ingresando coordenadas de Costa Rica al sistema y cambiando la 

proyección a un archivo vectorial. 

 

1. Posiciónese con el mouse sobre el nombre del archivo activo y de un clic derecho. 

Usted observara la ventana que se muestra en la figura 7. Luego seleccione 

Remove, para remover el archivo redcam_GAM_CRTM05. 

 

Figura 7.  Removiendo una capa de la vista principal 

 

2. Luego utilizando el icono  llame el archivo Red_Vial_LN.shp desde el 

directorio práctica. Este archivo esta proyectado en Lambert Costa Rica Norte, la 

cual utiliza el datum Ocotepeque. Las unidades de esta proyección son metros. 
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3. En la ventana de ArcTools seleccione Data Management Tools => Projections and 

Transformations => Define Projection. Esto nos permitirá definir la proyección en la 

cual estamos trabajando. Ver figura 8.  

 

 

Figura 8.  Definiendo la proyección a un tema o archivo visualizado 
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4. Haga doble clic sobre Define projection. Usted observara la siguiente ventana: 

 

 

Figura 9.  Definiendo el sistema de proyección para una capa 

 

5. De un clic sobre el explorador de carpetas y en Input Dataset or Feature Class, 

navegue hasta la carpeta práctica y seleccione el archivo Red_Vial_LN.shp y de un 

clic sobre el icono Add. 

 

6. Ahora de un clic sobre el icono de selección de sistema de coordenadas. Usted 

observara la siguiente ventana.  Ver Figura 10. 

 

Explorar carpetas 

Selecciona sistema de  
coordenadas 
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Figura 10.  Spatial reference de data Frame Properties 

 

7. Para agregar el sistema de coordenadas, váyase a la carpeta del programa 

ArcGIS que se encuentra en programas, en su disco local. Copie y pegue la carpeta 

de Costa Rica que le dará el instructor.  Esta carpeta contiene los sistemas de 

coordenadas para los sistemas de proyección Costa Rica Lambert Norte, Costa Rica 

Lambert Sur, Costa Rica CRTM90 y Costa Rica CRTM05.   Una vez que copió la 

carpeta en su ordenador, váyase a la vista principal de ArcMap y abra nuevamente la 

ventana de Spatial Reference Properties => XY Coordinate System. Pose el mouse 

sobre Favorites y de un click. Seleccione el ícono  y de un click sobre import...  

Aquí váyase al lugar donde guardó la carpeta Costa Rica y seleccione una a una los 

sistemas de proyección, agréguelos a la carpeta favoritos. Observe la figura 11. 
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Figura 11.  Inclusión del Sistema de Proyección al sistema. 
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Una vez que los sistemas de proyección están en su ordenador usted podrá 

asignarle a las diferentes capas la proyección.  Para definirle la proyección a la capa 

Red_Vial_LN en Favorites seleccione Proyección Lambert Norte y dele Aceptar.  

Este archivo contiene los parámetros de la proyección Lambert Norte para Costa 

Rica. 

 

8. Una vez seleccionada la proyección de origen del archivo Red_Vial_LN.shp, el 

siguiente paso es cambiar la proyección a CRTM05. En la ventana de ArcToolbox de 

un clic sobre Feature y luego dobre clic sobre Project. 

 

Figura 12.  Proyectando una capa o tema. 



 

  

 

14 

                                                                                                                                      

 

9. Al dar doble clic en Project se abrirá una nueva ventana (figura 13). En  Input 

Dataset or Feature Class navegue hasta la carpeta práctica y seleccione el archivo 

Red_Vial_LN.shp. En Output Dataset or Feature Class debe navegar hasta a la 

carpeta práctica y escribir un nombre para el archivo de salida (Red_Vial__CRTM05). 

Su ventana debe observarse de la siguiente forma: 

 

  

 

Figura 13.  Proyectando un tema 

 

10. El siguiente paso es seleccionar la nueva proyección del archivo de salida. En 

Output Coordinate System de un clic sobre al ícono  y en la nueva ventana en 

Favorites  seleccione el sistema de proyección Proyección CRTM05 y de clic en 

aceptar. Y luego Ok.   Su ventana debe lucir así: 
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Figura 14.  Proyectando un tema 

 

11. Remueva el archivo Red_Vial_LN.shp con Remove. 

 

12. Defina en la ventana del programa la proyección del archivo creado. 

Seleccione en la barra principal de herramientas seleccione View, Data Frame 

Propierties y luego de un clic sobre Coordinate System. Seleccione CRTM05 desde 

el layer o bien en Favorites y dele aceptar.  

 

 

 

 

 

 

 

 

 

 

 

 

Seleccionar 
proyección del 

archivo de 

salida 
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Ejercicio 3. Georeferenciando un tema. 

 

El proceso de georeferenciación se basa en asignar propiedades planimétricas a 

archivos vectoriales, imágenes u otros. En el siguiente ejercicio georeferenciaremos 

una foto aérea del proyecto CARTA 2005. 

1. Inicie el programa ArcMap . Seleccione Add Data  y navegue a la 

carpeta práctica y seleccione el archivo referencia.shp.  

 

Figura 15.  Selección de un archivo  

 

2. En View => Data Data Frame Properties => General, defina las unidades del 

programa como meters. Asegúrese también que el sistema de coordenadas sea 

Proyección CRTM05. 
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Figura 16.  Sistema de proyección 

 

 

 

 

 

Selecciona las unidades  

Cambia el sistema de proyección 
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3. Defina la proyección del archivo referencia.shp como Proyección CRTM05 Costa 

Rica en la ventana de ArcTools. 

 

4. Añada  el archivo 7335.jpg que se ubica en la carpeta práctica.  

 

5. Posicione el mouse sobre la barra de herramientas principal y de un clic derecho. 

Luego desplácese con el mouse y seleccione Georeferencing. Esta herramienta nos 

permite georeferenciar la imagen a partir de archivos vectoriales o imágenes 

previamente georeferenciadas. Figura 17.  

 

 

 

Figura 17.  Herramienta Georeferencing 

 

 

Usted observara esta barra de herramientas 
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6. Luego seleccione en Georeferencing, Fit to Display. 

 

 

Figura 18.  Herramienta Georeferencing_Fit to display 

 

Su ventana debe lucir así: 

 

Figura 19.  Ventana de ubicación de la imagen 
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7. Ahora añada el archivo redcam_GAM_CRTM05.shp. Este es un archivo vectorial 

de la red de centros de carreteras del gran área metropolitana.  

 

Cuando añada este archivo este se colocara sobre la foto aérea y el archivo 

referencia.shp.  

 

 

 

Figura 20. Llamando las capas para georeferenciar a la vista. 

 

Desactive el archivo redcam_GAM_CRTM05.shp dando un clic sobre el check.   

 

 

Figura 21. Desactivación de temas 
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8. Con el icono señalado (Figura 22) referencie la esquina de la foto aérea a la 

esquina correspondiente en el archivo referencia.shp  

 

 

  

Figura 22. Icono para georeferenciar aplicando puntos de control 

 

Mantenga el botón del mouse mientras se desplaza de esquina a esquina. 

El siguiente esquema muestra como realizar el proceso: 

                               

Figura 23.  Ubicación de los puntos de control 

 

9. Repita el paso anterior con la esquina superior izquierda, hasta obtener el 

siguiente resultado: 

 

 

 

 

 

 

 

 

 

 

 

Figura 23.  Sobreposición de archivo shape sobre la imagen 

Icono  

El archivo referencia.shp sobrepone completamente a 
la foto aérea 7335. 
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10. Con el icono   llame la tabla de puntos de control (Link Table). 

 

 

Figura 24.  Tabla de georeferenciación 

 

y elimine los primeros dos puntos marcándolos con el botón izquierdo del mouse y  

el botón shif    , luego de un clic sobre . No cierre la ventana, manténgala activa. 

 

Figura 25.  Tabla de georeferenciación 

 

Remueve o desactive el archivo referencia también. Dando clic sobre el chek 

o bien con clic derecho sobre  el nombre del archivo y luego de click 

sobre Remove. 
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11. Rote la foto aérea 7335 hacia la izquierda utilizando la herramienta 

Georeferencing , Flip or Rotate, Rotate Right. Repita este procedimiento 

nuevamente. 

 

 

 

Figura 26.  Rotar imagen 

 

12. Active el archivo redcam_GAM_CRTM05.shp y comience a seleccionar puntos 

de control congruentes entre la foto aérea y el archivo de carreteras. Utilizando el 

zoom busque los sitios y utilizando el icono  marque un punto en la foto y 

después en el archivo de carreteras como se muestra en el siguiente ejemplo. 
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Figura 27.  Imagen a georeferenciar con calles ubicadas como base 

 

Si desea cambiar los colores de las calles de un doble clic sobre el archivo 

redcam_GAM_CRTM05.shp y en la ventana que se muestra seleccione Symbology. 

Luego de un clic sobre el icono cercano a Symbol para abrir la ventana de Symbol 

Selector y en el icono cercano a Color de un clic y seleccione el color deseado. 

 

 

Figura 28.  Ventana de símbolos del tema 
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13. Conforme usted selecciona puntos de control, usted puede ver el error medio 

cuadrático RMS en la tabla con el icono . Un ejemplo se muestra a continuación: 

Esta tabla muestra los puntos de control que usted ha colocado.  En este caso 

existen 13 puntos de control. 

 

 

 

 

 

 

 

 

 

 

Figura 29.  Tabla de puntos de control 

 

 

 

 

 

 

En esta casilla el 
programa calcula el 

RMS.  En este caso es 
de 16,2527. 

Se define la ecuación a utilizar para 
calcular el RMS 
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14. Cuando termine de colocar los puntos de control seleccione Georeferencig, 

Update Georeferencing y luego Rectify y usted observara la siguiente ventana. 

 

 

 

  

 

Figura 30.  Rectificando la imagen 

 

Nota: el tamaño de celda debe ser igual o superior al tamaño de celda del archivo 

original. 

 

Con estos pasos usted tendrá el archivo ya georeferenciado, elimine las otras capas 

y llame a la vista el archivo guardado ya georeferenciado. 

 

 

 

 

 

 

 

Se define el 
tamaño de celda 

Indica el 
método de 
remuestreo de 
la imagen  

(resample) 

Se define la carpeta 
donde guardar la foto 
aérea 
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Ejercicio 4. Creación de archivos vectoriales utilizando ArcCatalog 

 

En esta sección usted utilizara las herramientas para edición de archivos en formato 

vectorial. Usted utilizara el archivo uso_cobertura.shp para dibujar y editar los 

parches de bosque y pasto en el área de la sabana.  

 

1. Inicie el programa ArcCatalog con el icono .  

2. En el menú principal seleccione File/New/Conect to Folder/ y elija el lugar donde 

va  a guardar los archivos nuevos a crear .  Una vez que tenga la carpeta activa en la 

ventana de contentes selecciónela y váyase nuevamente a File/new/Shape file.  El 

nombre debe ser uso_cobertura.shp , mientras que el Feature Type es Polygon. 

Asegúrese de tener activa la carpeta práctica. 

 

 

      Figura 31. Creación de un archivo shp. 

 

Usted puede crear tres tipos archivos 
vectoriales: 
Puntos (objetos puntuales), líneas 
(carreteras, ríos) y polígonos (áreas) 
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Figura 32.  Selección del tipo de archivo a crear 

 

3. Regrese al programa ArcMap  y añada el archivo uso_cobertura.shp que 

usted creó. 

4. En la barra de herramientas del Editor  seleccione Start Editing  

 

Figura 33. Editor del programa 

Seleccione el tipo de archivo a 
crear para este caso polígono. 

Nombre el archivo como 
uso_cobertura 
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Haga un click sobre el  icono  se le abrirá una nueva ventana al lado derecho de 

su pantalla, debe aparecer la capa de uso_cobertura. En la parte inferior de la 

ventana aparece una herramienta Construction Tools. Seleccione Polygon y váyase 

a la vista principal y dibuje un rectángulo para limitar el área del parque metropolitano 

la sabana como se muestra en el siguiente ejemplo: 

 

 

Figura 34.  Trazado de polígono sobre la imagen 

5. Cuando termine de dibujar el polígono en la barra de herramientas del Editor 

seleccione Save Edits y luego Stop Editing. Luego desactive el archivo 

uso_cobertura.shp. 

 

6. En la barra de herramientas de dibujo seleccione New Polygon. 

 

Figura 35.  Barra de herramientas de dibujo 

Icono para dibujar polígono 

Barra de herramientas de dibujo 
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7. Utilizando esta función dibuje todos los parches de bosque presentes en la 

sabana. Los parches de bosque se pueden identificar por su coloración roja y textura 

irregular, además es posible observar las copas de árboles de mayor dimensión. El 

siguiente ejemplo muestra la digitalización de un parche de bosque. 

 

 

Figura 36. Trazado de polígonos 

 

8. Con un clic derecho sobre la barra principal de herramientas seleccione la 

extensión Draw. Seleccione los polígonos en la vista. En la extension Draw 

seleccione Drawing/Convert Graphics to Features/. Denomine los polígonos de 

bosque como área_bosques.shp y los polígonos de pasto como área_pastos.shp.  

 

Figura 37.  Herramientas de Drawing 

 

Parche de bosque digitalizado 

Parche de pasto digitalizado 
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Figura 38.  Opción de convertir dibujos a características 
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Ejercicio 5. Geoprocesamiento de archivos vectoriales mediante la extensión 

Geoprocessing  

 

1. Desde la barra principal de herramientas de ArcMap usted encontrará la extensión 

Geoprocessing, haga clic sobre esta.  Usted observará la siguiente ventana: 

 

 

Figura 39.  Ventana de Geoprocessing 

 

2. Utilizando el icono Unión de la extensión Geoprocessing  genere una nueva 

cobertura que contenga los dos tipos de clasificación (pastos-bosques). De un clic al 

icono Union y usted observará la siguiente ventana: 
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Figura 40.  Ventana de la herramienta Union 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

En Input Features seleccione 
las dos coberturas creadas 

por usted (bosques y pastos). 
 

En Output Feature Class de 
un nombre al archivo de 

salida (ejem uso_cobertura) y 
guárdelo en la carpeta 
práctica. Al final OK. 
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Ejercicio 6. Selección simple y mediante atributos, exportación de capas y 

elementos seleccionados 

 

A continuación usted utilizara el archivo clasificacion.shp. Este archivo corresponde a 

un trabajo de clasificación de uso del suelo en una parcela de la zona sur de Costa 

Rica. 

 

1. Añada el archivo clasificacion.shp en ArcMap. Fije la proyección del archivo y las 

propiedades del programa. Seleccione alguno de los polígonos de esta capa, eso se 

hace con el ícono   de la barra de herramientas Standard. revise la información 

del polígono seleccionado desde la tabla de atributos o con el icono de identify. 

2. Desde la barra principal de herramientas  seleccione Selection, Select By 

Attributes. 

 

 

Figura 41. Selección por medio de atributos 

 

3. Para exportar el archivo váyase a la tabla de contenidos y pósese sobre el nombre 

del tema, de un clic derecho, clic sobre Data/ Export Data y seleccione el archivo de 

salida.  Con esto usted puede exportar temas o seleccionar y exportar áreas de 

interés. 
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4. En la siguiente ventana seleccione lo siguiente: 

1. Layer: clasificación 

2. Method: Create a new selection 

3. Fields: “Uso del Suelo” (debe dar un doble clic) 

4. Seleccione el símbolo = en el menú de iconos. 

5. Unique values: “Bosque” (debe seleccionar primero Get Unique Values) 

6. Y finalmente apply. 

 Su ventana debe lucir así: 

 

 

Figura 42.  Ventana de selección por medio de atributos 

 

 

 

 

 

Ahora usted observara como se resalta en el 

archivo clasificación.shp las áreas de bosque. 

Usted puede buscar otros usos del suelo en 

esta parcela, para hacerlo debe dar un clic 

sobre el icono clear y después seguir los 

pasos anteriores. 
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5. Inicie ArcCatalog, navegue hasta a la carpeta práctica y seleccione el archivo 

clasificación.shp como se muestra a continuación: 

 

 

Figura 42.  Seleccionando archivos desde ArcCatalog 

 

 

6. Luego seleccione Preview, esto le permite visualizar el archivo. Luego seleccione 

Table en la ventana de preview que esta en la parte inferior del programa. 

 

 

 

Figura 43.  Selección en preview 

 

7. Regrese al programa ArcMap. Vaya a la vista del layer y presione click derecho 

sobre la capa clasificación. Luego seleccione . Open atributte table.  
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Figura 44. Tabla de atributos 

 

8. En la tabla seleccione el ícono  y luego Add Field.  

 

Usted observará la siguiente ventana: 

 

Figura 45.  Ventana de agregado de columnas  

En name escriba cambio_uso.  
 
En Type seleccione Text 
 
En length escriba 20, para tener 
20 campos para escribir 
 
Luego OK 
 
Usted observara una nueva 
columna en la tabla 
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Nota: En la opción Type usted puede seleccionar: 

 Short integer 16 bit (216) desde -32 000 a +32 000 

 Long integer 64 bit (264) 

 Float el punto decimal puede estar en cualquier posición entre los dígitos: 

2.7931, 10398.8798, etc. Puede guardar hasta siete dígitos significativos 

(izquierda y derecha del punto decimal). Su profundidad es de 32 bit y va 

desde -3.4E-38 hasta -1.2E38 para números negativos y de 3.4E-38 hasta 

1.2E38 para números positivos. 

 Double 64 bit. Puede guardar hasta 15 dígitos significativos. 

 Blob para guardar imágenes u objetos 

 Texto puede ser de longitud variable 

 Date fechas 01/05/1980 

 

 

9. Regrese al programa ArcMap y seleccione Start Editing para el modo de edición 

del archivo clasificacion.shp.  

 
Ahora usted puede escribir en la columna cambio_uso. Si esta fuera su finca como 

cambiaría el uso de la tierra. Escriba las nuevas coberturas en la columna 

cambio_uso. Si usted da un doble clic sobre cualquier hilera en la tabla observará 

iluminado el área correspondiente en el archivo clasificación.  

 

10. Cuando termine de llenar la columna de cambio_uso seleccione en el menú de 

Editor, Save Edits y luego Stop Editing 

 

Si lo desea puede visualizar la clasificación dando un doble clic sobre clasificación en 

la subventana de layers. Usted observará la siguiente ventana: 
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Figura 46.  Ventana de simbología del tema 

 

En Symbology, seleccione Categories, Unique values. Luego Add All Values y 

finalmente Aplicar y Aceptar. 
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Ejercicio 7 . Elaboración de un mapa  

Para la elaboración de un mapa es necesario colocar etiquetas, editar nombres, 

nombrar el mapa. Buscar símbolos representativos para identificar los puntos de 

interés. Se deben establecer condiciones de tamaño, orientación, modificar 

márgenes. Además, tome en cuenta que en la información del mapa debe incluirse 

leyenda, escala, norte, título del mapa y cuadrícula de coordenadas. Indicar el 

autor(es), fecha de elaboración, proyección y fuente.  

Los pasos son los siguientes: 

1. Vaya a la hoja del mapa, esto se hace en View/Layou View. 

2.  Con el comando Page and Print Setup del menú File configure las propiedades de 

impresión, como se muestra en la figura 47 

 

Figura 47 .  Propiedades de impresión 
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3.  Utilizando el comando Change Layout de la barra de herramientas Layout elija la 

lámina predeterminada LandscapeModernInset.mxt 

 

 

Figura 48. Selección de comando Change Layout 

 
 

 

Figura 49. Selección de tipo de plantilla 

 

4.  En la ventana Data Frame Order  ( Figura ), coloque la capa que desea que 

aparezca como principal en (1) y en (2) la capa secundaria, que este es utilizado 

para mostrar la ubicación general del proyecto a macroescala puede ser la ubicación 

en Costa Rica del sitio de muestreo. Una vez seleccionadas de click en Finalizar. 
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Figura 50 .  Orden de los Data Frame en la lámina predeterminada LandscapeModerInset.mst 

 

5.  Haga doble clic sobre el espacio correspondiente y coloque el título del mapa. 

 

 Figura  51. Ubicando título al mapa 
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6. Acomode la simbología en uno de los cuadros, y póngale como título "Simbología". 

La Simbología aparece por defecto, sin embargo, es necesario darle un nombre 

apropiado, esto se logra dando doble clic sobre la leyenda y abre la opción de 

Legend Properties. 

 
Figura 52.  Ventana de propiedades de la legenda 

 
7.  Utilizando la herramienta de Insert del menú principal coloque el norte y las 
escalas. Para el Norte, seleccione la opción North Arrow. 
 

 
 

Figura 53.  Ventana de símbolos norte del sistema 
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Para las escala seleccione Scale Bar y Scale Text, abra las ventanas y seleccione la 
que mejor desee, en propiedades puede modificar las unidades, el tamaño de la 
letra, el grosor, la cantidad de divisiones, entre otros. 

 

 
 

Figura 54.  Ventana de escalas de barra 

 
8. Agregue la malla de coordenadas. 
 
Para agregar una malla de Coordenadas, vaya a la vista del mapa y sobre el Data 
Frame (1) haga clic derecho y seleccione Properties... 
En la ventana que se abre seleccione Grids/ New Grid...y configure las propiedades 
de la malla como se indica a continuación: 
 
En la venana Grids and Graticule Wizard, donde le pregunta, whic do you want to 
create? (Qué quiere hacer?), debe marcar Measured Grid: divides map into a grid of 
map units.  El Grid name puede dejarlo por defecto o cambiarlo.   
 

         
 

Figura 55.  Ventanas de grilla o maya de coordenadas 
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En la ventana Create a measured grid. En Appereance debe elegir Grid an Labels . 
En COordinate System presione el Botón Properties... y verifique que el sistema de 
proyección sea CRTM05. Elija los intervalos X Axis: 10000 m y Y Axis : 10000 m 
 
Elija el resto de características a su gusto. Observe que puede cambiar la apariencia 
de líneas y texto.  
 
Su proyecto puede lucir así: 
 

 
 

Figura 56.  Mapa de ejemplo 


